1Q-200
Optical Test System

Instruction Manual
Seventh Edition
P/N: MAN-056-1 .7ACE

If the equipment described herein bears the C E symbol, the said equipment complies with
the European Community Directive and Standards found in the Declaration of Conformity.

If the equipment described herein bears an FCC staternent, the said equipmen! complies with
the relevant Federal Communications Commmission standards.



All rights reserved. No patrt of this publication may be reproduced, stored in
a retrieval system, or transmitted in any form or by any means, be it

electronic, mechanical, photocopying, recording, or otherwise, without the
prior written permission of EXFO Electro-Optical Engineering Inc. (EXFO).

Information provided by EXFO is believed to be accurate and reliable.
However, no responsibility is assumed by EXFO for its use nor for any
infringements of patents or other rights of third parties that may result from
its use. No license is granted by implication or otherwise under any patent
rights of EXFO.

EXFO’s Commerce And Government Entities (CAGE) code under the North
Atlantic Treaty Organization (NATQ) is 0L8C3.

The information contained in this manual is subject to change without
notice.

© 2001 EXFO Electro-Optical Engineering inc.

Words which we consider as trademarks have been identified as such.
However, neither the presence nor absence of such identification affects
the legal status of any trademark.

March 2001



Contents

Contents

Certification INfOrMatioN .......cooii i et e e r st e s s e e v
1 1Q-200 Optical Test System Overview ..........ccccorermverinnannennee remmeres rerrssseenn 1

[0 R O oY} (o] IRV T OO 1

1Q-206 Expansion Unit

1Q-206 Expansion Card

Remote Control of the 1Q-200 Optical Test System ......oooivicciiiriiiiecriirecee e e 8
2 Safety Information ............. HeeemsseseesissisesssssesessserssaEEssserssssersssesssserasseesesERernntn 9

Safety CONVENTIONS. ... .oociiee ettt e e e e e eae e s

N =3 AV o (=T LU {3 T OO ORI
Electrostatic Discharge Precautions
AC and Power Cable Requirements

3 Installing and Connecting the 1Q-200 Hardware .................. crenmeees S, 13
Setting Up the 1Q-200 for RACk-MOUNT USE......c..oooiiiieiiecie it creeeeseee e s e e s enreeennes
Connecting 1Q-206 Expansion Units to an 1Q-203 Control Unit
Installing the 1Q-206 EXPansion Card ..........ccccoeieerveveeeiceniieessece s bere e e e s e e e e e s s
Connecting 1Q-206 Expansion Units to an 1Q-206 Expansion Card

4 Installing and Configuring the 1Q-200 Software ......cccccomiimiciririicncrennenas 27
Installing the 1Q-200 Software
Configuring the 1Q-200 Drivers
Uninstalling the 1Q-200 Software

5 Using the 1Q-200 Optical Test System ... s
Getting Started with the 1Q-203 Control Unit ... e e
Getting Started with the EXpansion Card ............cccceeeiiiiereiiniiciec e eeaaa s
Inserting Modules in the 1Q-203 OF [Q-206...........ccoviiiiiiceie i ce e ee e et e e sneee
Removing Modules from the 1Q-203 or 1Q-206
Understanding the 1Q-200 SOTIWATE .......uen e e e s
Customizing the 1Q-200 Optical Test SYSTeIM .......ceviiniiiieiiie et e e e eee e e s eeeees e saaraans
Starting and Using Module Applications ...........cccoeeeiiiiiieincn i e
Displaying the Module Monitor Window ..........c..cceeuiiiiiinieie e
Controlling the 1Q-200 Remotely......ccccciviiiiiiici e
Exploring Drive Contents and Running External Software
Getting Help in the 1Q-200 SOftWare..........cccooiiv it
Powering the 1Q-200 Optical Test System Off .......ccoooiiiiiiie e ens

Optical Test System



Contents

6 Maintenance and Troubleshooting .....cccceceuiiiiiiiciiiiien i e 59
Cleaning the 1Q-203 Control Unit and 1Q-206 Expansion Unit.........cccceveiveermnncinnnnciennnnnnenns 59
RePIaCing the FUSES ... e e s 60
Defragmenting Drives and FIles.........c.cooveiiiiiiiiiiiiecte et e e 61
Scanning Hard Disks fOF EITOIS .......ooviiii it e e e e ee st s e e s esessres s s e s s 61
Troubleshooting the 1Q-203 Control Unit and 1Q-206 Expansion Unit............c.ccceeieiiiriiis 62
Troubleshooting the 1Q-206 EXPansion Card ...........ccceeveiiiicenniiinneeeeerseresnee s eenserssnenes 63
Transportation and STOrage.........cooviiiciiiiiiiie et e e s 64
Contacting the Customer SErvice GroUP ..ot e e 64

7 Technical Specifications ... e s v 65
Electrical SPecifiCations .......ceeun ittt bt ee e e s 65
Mechanical SPECHICAtIONS .........oviiiieiiei et 65
Environmental SPecifications ...t e 66

8 Warranty ...t iir e e e s sk es e s e e m e ssa R s a e na e rnnenen 67
GENEral INTOIMATION ..cciiiiie ettt e e st e s s s s esat s e e e e essaeenes 67
(21 o111 428 OO OO PE P PUUTOTORS 68
EXCIUSIONS. .. e ettt ettt see et ee e s eiteeaeaeeeeetesrouesas s e e naraesasen e e ee s aas bt esrsee e ae e e nnnenanen 68
CMEITICATION Louveeee ittt b s e e e e st saaasaanr e s sbeas e s s e s s seesesaaensen s senebasessesans 68
SEIVICE AN REPAITS ..eeneeiiniiiieireiirirree ettt et e e s se s s ee e sar e e s e s sbesste s s e s e sabanebesas 68

A 1Q Modules and Typical Applications .......counrocrrneee e cceccenes 71
LiSt OF HQ MOAUIES ..o et st eeree e e e e s e e et bbaree e e sn e e s s sane s 71
Typical Applications for IQ Modules ..ot 72

B Using the 1Q-9600 Utility Module ......ccoemcrireereiccrinreeeesemcnennsenesesesnsennses 75
Exploded View of Single-Slot Utility Module ..........ccooriiii e, 76
Exploded View of Double-Slot Utility ModUIE .........evuriiiiiiiiiii et 77

C Accessing a Remote CD-ROM Drive with the1Q-203 ...............ccccnccuueeee 79
Sharing the CD-ROM Drive from the PC ........coceeiiiiiiiieciec ettt et e 79
Accessing the Remote CD-ROM from the 1Q-203 Through a Network..........ccocveieieininiiininnn. 80
Accessing the Remote CD-ROM from a PC Connected Directly to the 1Q-203..............cceneee. 81
Troubleshooting Direct Cable CONNECUON ......c.eeveiereeeeie ettt e e e e 85

1L = Y 87

iv 1Q-200



Certification Information

Certification Information

F.C.C. INFORMATION TO USER

This product has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 (Subpart B) of the FCC Rules.
These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This unit generates, uses, and can
radiate radio frequency energy and, if notinstalled and used in accordance
with the instruction manual, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not
occur in a particular installation. If this unit does cause harmful
interference to radio or television reception, which can be determined by
turning the unit off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
» Increase the separation between the unit and receiver.

» Connect the unit into an outlet on a circuit different from that to which
the receiver is connected.

» Consult the dealer or an experienced radio/TV technician for help.

WARNING

Changes or modifications not expressly approved by EXFO
Electro-Optical Engineering Inc. could void the user’s authority to
operate the unit.

Optical Test System v



Certification Information

» This unit is equipped with a shielded three-wire power cord and plug.
Use this power cord in conjunction with a properly grounded electrical
outlet to avoid electrical shock and to reduce radio frequency
interference that may emanate from the power cord.

» Use of shielded remote 1/O cables, with properly grounded shields and
metal connectors, is recommended in order to reduce radio frequency
interference that may emanate from these cables.

» When the GPIB option is present, this unit is equipped with a shielded
GPIB cable.

INDEPENDENT LABORATORY TESTING

This product has undergone extensive C € certification testing both
internally, at EXFO, and externally, at an independent, qualified laboratory.
All pre-qualification tests were performed at EXFO while all final tests were
performed at UltraTech Engineering Labs Inc., a renowned test laboratory
from Mississauga, Canada. This guarantees the unerring objectivity and
authoritative compliance of all test results.

C E INFORMATION TO USER

This product has been tested and found to comply with the limits for a
Class B digital device. Please see the Declaration of Conformity.
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1 1Q-200 Optical Test System
Overview

The 1Q-200 product line is a modular optical test systemn designed for
laboratory application. Thanks to the Windows compatible 1Q-200
Software, the 1Q-200 Optical Test System combines power, performance,
and flexibility with a user-friendly interface. The main components of the
system are the 1Q-203 Control Unit, which can house up to three modules,
and the 1Q-206 Expansion Unit, which can house up to six modules. It is
also possible to control 1Q-206 Expansion Units with an 1Q-206 Expansion
Card inserted in a PC.

1Q-203 Control Unit

The 1Q-203 is the mainfrarne of the 1Q-200 Optical Test System. The 1Q-203
controls all the modules, whether they are inserted in the 1Q-203 itself or in
an 1Q-206 Expansion Unit. The standard 1Q-203 integrates a Pentium MMX
microprocessor PC architecture. It can be equipped with a network
interface card (Ethernet or other), allowing you to connect to a Local Area
Network (LAN).

The Windows compatible 1Q-200 Software simultaneously controls all
modules via the 1Q-203 bus. Upon delivery, this software is already installed
on the 1Q-203 Control Unit and ready to run. For more information about
the 1Q-200 Software, see Using the 1Q-200 Optical Test Systern on page 35.

All software commands can be controlled with the hardware keys and
mouse provided on the unit front panel. However, an external mouse and
an optional keyboard allow easier operation. Also, the addition of a VGA
monitor can enhance the visual aspect of the applications, just as a printer
can be useful for producing hard copies.

The 1Q-203 has room for three single-slot interchangeable modules and
can control up to four IQ-206 Expansion Units: the total system capacity is
27 single-slot modules. For more information about a typical 1Q-200 setup,
see Installing and Connecting the 1Q-200 Hardware on page 13.

In addition to operating the IQ modules, any commercial software
(spreadsheets, word processors, etc.) can also be installed on the 1Q-203,
although the warranty may be void in certain cases.

Optical Test System 1



1Q-200 Optical Test System Overview
1Q-203 Control Unit

1Q-203 Front Panel

3.5” high density Integrated
floppy disk drive VGA display
Loads or saves data on
floppy disk.
Front panel keys Front panel mouse 1Q modules
Activate different software Activates software
commands (see Using the commands, like a
Front Panel Keys on conventional mouse.
page 43). |
|
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Contrast buttons Hard disk drive LED
Set the contrast of the IHuminates when the hard
integrated VGA screen. disk drive is in use.
ON/OFF button Brightness buttons Retractable legs
Powers the 1Q-203 Set the brightness of the Facilitate the inclination of
on and off. integrated VGA screen. the 1Q-203.
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1Q-200 Optical Test System Overview
1Q-203 Control Unit

1Q-203 Back Panel

Additional DBI serial port (optional) Modem card  Certification and

and ports warning label
GPIB port {optional) (optional)
N 0 Q //
(o] D (o]
—Fan
Fan Do
)
SHETTITTDE oG5 S = | Fuse
iR @ - I holder
o—mo 0"E'o’n‘-'90 , e 5,% :
Nameplate o o o
i AC socket
1Q-206 port Monitor port Keyboard port
Mouse port (PS/2)

Printer port DB serial port

Note: Actual ports on your unit may differ from those depicted in the illustration.

This symbol, found at the back of the 1Q-203 Control Unit,
indicates that you should refer to the instruction manual for fuse
replacement and power rating. The fuse replacement
procedure is given in Replacing the Fuses on page 60.

This device complies with part 15 of the FCC rules. Operation is

subject to the followil ditions: (1) this de:
ha ¥ is device must acc
cludi that may cau:

Part number ___ S - 503 44 B-1.0[% _— Product version

: 21325- JANUARY 200173 crro e :
Serial number — N S1A G meae — Manufacturing
Made in Canada QsT-94 Vaner, Que.. Canada G1M 3G7 date
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1Q-200 Optical Test System Overview
1Q-206 Expansion Unit

1Q-206 Expansion Unit

The 1Q-206 is called the expansion unit of the 1Q-200 Optical Test System
because it is usually used to expand the module capacity of an 1Q-203
Control Unit. You can link up to four 1Q-206 Expansion Units to an 1Q-200
Optical Test System. Each 1Q-206 Expansion Unit can support up to six
modules, which are either controlled from an 1Q-203 Control Unit or an
1Q-206 Expansion Card, via the Windows compatible 1Q-200 Software.

You can find installation instructions for the 1Q-206 Expansion Unit in
Installing and Connecting the 1Q-200 Hardware on page 13, as well as help
with the software in Using the 1Q-200 Optical Test Systern on page 35.

1Q-206 Front Panel

Sequential position display

Indicates the position of the unit within the
1Q-200 system. The unit closest to the |Q-203
Control Unit or 1Q-206 Expansion Card is
numbered 1, the second closest is numbered
2, etc., up to four IQ-206 Expansion Units.
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Powers the 1Q-206 on and off.
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1Q-200 Optical Test System Overview
1Q-206 Expansion Unit

1Q-206 Back Panel

Fan Certification and Fuse
| warning label holder
0 /1
Fan &
& —~—
a H H
Nameplate &%

1Q output port 1Q input port

Used to link the unit Used to link the unit
to another 1Q-206 to an 1Q-203 Control
Expansion Unit Unit, 1Q-206 Expansion

Card, or 1Q-206
Expansion Unit

This symbol, found at the back of the 1Q-206 Expansion Unit,
indicates that the user should refer to the instruction manual for
fuse replacement and power rating. The fuse replacement
procedure is given in Replacing the Fuses on page 60.

NO C
and (2) this

Part number
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— I 1a 206 -1 -1.0 K —— Product version
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1Q-200 Optical Test System Overview
1Q-206 Expansion Card

1Q-206 Expansion Card

The 1Q-206 Expansion Card is designed to emulate an 1Q-203 Control Unit.
Once installed in a PC, the 1Q-206 Expansion Card allows you to control up
to four 1Q-206 Expansion Units, which represent 24 single-slot 1Q modules.

To operate the 1Q-206 Expansion Card, you need to install the Windows
compatible 1Q-200 Software on the host computer. The 1Q-200 Software
used with the 1Q-206 Expansion Card is identical to the software on the
1Q-203 Control Unit.

» For information about how to connect the 1Q-206 Expansion Card to an
1Q-206 Expansion Unit, see Installing the 1Q-206 Expansion Card on
page 19.

» For details about installing the software on a PC, see Installing the
1Q-200 Software on page 27.

» For help with the use of the software, see Using the IQ-200 Optical Test
Systern on page 35.

Your 1Q-206 Expansion Card will look different depending if it is an ISA or
PCI card and the installation method will be different. Use the following
illustrations to determine whether your card is ISA or PCL

6 1Q-200



1Q-200 Optical Test System Overview
1Q-206 Expansion Card

PCI Expansion Card Diagram
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1Q-200 Optical Test System Overview
Remote Control of the 1Q-200 Optical Test System

Remote Control of the 1Q-200 Optical Test
System

In addition to stand-alone operation, the 1Q-200 Optical Test Systern can be
remotely controlled through one of the following methods:

>
>
>
>

GPIB interface
RS-232 external interface
Windows OLE (Object Linking and Embedding) automation

Windows DDE (Dynamic Data Exchange) communication channel

The GPIB and IQ-Application Development Guide, included with each
1Q-203 Control Unit and 1Q-206 Expansion Card, explains the different
integrated configuration options and describes in detail how to create
high-level integrated applications.

CAUTION

Devices that will allow the 1Q-200 Optical Test System to be controlled
remotely must be installed at the factory. Attempting to install any
other device will void the product warranty.

1Q-200



2 Safety Information

Safety Conventions

You should understand the following conventions before using the product
described in this manual:

WARNING
Refers to a potential personal hazard. It requires a
procedure which, if not correctly followed, may result
in bodily harm or injury. Do not proceed beyond a
WARNING unless you understand and meet the
required conditions.

CAUTION

Refers to a potential product hazard. It requires a
procedure which, if not correctly followed, may result
in component damage. Do not proceed beyond a
CAUTION unless you understand and meet the
required conditions.

IMPORTANT

Refers to any information regarding the operation of
the product which you should not overlook.

Safety Precautions

The following safety precautions must be observed while operating and
servicing the units. Failure to comply with these precautions or with
specific indications elsewhere in this manual violates safety standards of
intended use of the unit. EXFO assumes no liability for the user's failure to
comply with these requirements.

CAUTION

Use of controls, adjustments and procedures for operation and
maintenance other than those specified herein may resuit in

hazardous radiation exposure.

Optical Test System 9



Safety Information
Electrostatic Discharge Precautions

10

WARNING

The 1Q-203 Control Unit was designed to be a test instrument that
should not be opened by users. EXFO is not responsible for any
personal injury incurred while attempting internal service of the
1Q-203 Control Unit or 1Q-206 Expansion Unit.

»
»

Unit covers cannot be removed during operation.

Before powering on the unit, all grounding terminals, extension cords,
and devices connected to it should be connected to a protective
ground via a ground socket. Any interruption of the protective ground
will cause a potential shock hazard and possible personal injury.

Whenever the ground protection is impaired, the unit must not be used
and be secured against any accidental or unintended operation.

Only fuses with the required rated current and specified type (normal
blow, time delay, etc.) may be used for replacement. Do not use
repaired fuses or short-circuited fuse holders.

Any adjustments, maintenance, and repair of opened units under
voltage should be carried out only by skilled personnel aware of the
hazard involved. Do not replace any components while power cable is
connected. EXFO is not responsible for any personal injury incurred
while manipulating the unit.

Operation of any electrical instrument around flammable gases or
fumes constitutes a major safety hazard.

Capacitors inside the unit may be charged even if the unit has been
disconnected from its electrical supply.

Electrostatic Discharge Precautions

Electrostatic discharge (ESD) precautions must be taken at all times while
handling the 1Q-206 Expansion Card. Always work at an approved ESD
work station or use an ESD ground strap when handling the 1Q-206
Expansion Card.

1Q-200



Safety Information
AC and Power Cable Requirements

AC and Power Cable Requirements

The 1Q-203 can operate from any single-phase AC power source between
100 V and 240 V (50/60 Hz). The maximum input current of the 1Q-203 is
1.5A.

The 1Q-206 can operate from any single-phase AC power source between
100 V and 240 V (50/60 Hz). The maximum input current of the 1Q-206 is
3.0A.

This unit uses an international safety standard three-wire power cable. This
cable serves as a ground when connected to an appropriate AC power
receptacle. The type of power cable supplied with each unit is determined
according to the country of destination. The figure below illustrates the
different power cables available.

Europe

Australia ] L
— o Great Britain
Lod
South Africa — @ T United States
)

Only qualified electricians should connect a new plug if needed. The color
coding used in the electric cable depends on the cable. New plugs should
meet the local safety requirements and include the following features:

» adequate load-carrying capacity
» ground connection

» cable clamp

Optical Test System 1



Safety Information

AC and Power Cable Requirerments

12

WARNING

To avoid electrical shock, do not operate the unit if there are signs of
damage to any part of the outer surface (covers, panels, etc.). To
avoid serious injury, the following precautions must be observed
before powering ON the unit.

If the unit is to be powered via an auto transformer for voltage
reduction, connect the common terminal to the grounded power
source pole.

Insert the power cable plug into a power outlet with a protective
ground contact. Do not use an extension cord without a protective
conductor.

Before powering ON the unit, connect the protective ground terminal
of the unit to a protective conductor using the unit power cord.

Do not tamper with the protective ground terminal.

1Q-200



3 Installing and Connecting the
1Q-200 Hardware

The 1Q-200 Optical Test Systemn can include up to four IQ-206 Expansion
Units connected in a daisy chain with an 1Q-203, allowing 27 single-slot
linked modules. Mounting all these units into a standard 19-inch
equipment rack is an efficient setup, but units can easily and safely be
stacked one on top of the other in benchtop format, as shown below:

Whether you select the benchtop or rack-mount setup for your system, you
will always be able to take full advantage of the flexibility and expansion
characteristics of the 1Q-200 Optical Test System.

For additional flexibility and ease of use, you can add an external color VGA
monitor, keyboard, and mouse to the 1Q-203 Control Unit. The IQ modules
are linked together by the [Q-203 interface bus.

Optical Test System 13



Installing and Connecting the 1Q-200 Hardware
Setting Up the 1Q-200 for Rack-Mount Use

Setting Up the 1Q-200 for Rack-Mount Use

Each 1Q-203 Control Unit and 1Q-206 Expansion Unit has two rear cooling
fans. Mount or position the units so that air can circulate freely around
thern. When operating the unit, choose a location that provides at least

» 75 mm (3 inches) of rear clearance
» 25 mm (1 inch) of side clearance (left and right)
» 25 mm (1 inch) of top clearance

Failure to provide adequate cooling clearance may result in an excessive
internal temperature, thus reducing unit reliability.

Before being inserted into a rack, 1Q-203 Control Units or 1Q-206 Expansion
Units must first be installed into an optional rack-mount kit. To do so,

1. Assemble the rack-mount panels and handles using the screws and
lockwashers supplied with the kit.

Handle screw Left panel

Lockwasher

Front panel Right panel

Lockwashers

Handles

14 1Q-200



Installing and Connecting the 1Q-200 Hardware
Setting Up the 1Q-200 for Rack-Mount Use

2. Power OFF the 1Q-203/1Q-206 and remove the four bottom cover
screws under the 1Q-203/1Q-206 as shown below.

3. Slide the 1Q-203/1Q-206 inward through the rack-mount front panel,
with the front of the unit facing you. Be careful not to break the
warranty stickers on the 1Q-203/1Q-206.

1Q-203/206 Front panel \

— —

Cover Cover
screws SCrews

S N

Rack-mount front panel\

R |
v v
L
a
Flange
Left lange ——— screws —+———/Right flange
Left panel ——— ~—————Right panel
_ L
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Installing and Connecting the 1Q-200 Hardware
Setting Up the IQ-200 for Rack-Mount Use

4. Use the flange screws and flat washers supplied with the kit to secure
the 1Q-203/1Q-206 onto the rack-mount flanges.

5. Insert the rack-mounted 1Q-203/1Q-206 into the cabinet as shown
below and secure in place using the hardware supplied with the rack.

16 1Q-200



Installing and Connecting the 1Q-200 Hardware
Connecting I1Q-206 Expansion Units to an 1Q-203 Control Uni

Connecting 1Q-206 Expansion Units to an
1Q-203 Control Unit

Up to four 1Q-206 Expansion Units can be connected to the 1Q-203 Control
Unit, which represents a total of 27 single-slot modules. The necessary
interface cable to connect an 1Q-206 Expansion Unit to another 1Q-206
Expansion Unit or 1Q-203 Control Unit is supplied with the 1Q-206
Expansion Unit. Connections are shown on the next page.

Note: As the IQ-206 Expansion Units are daisy chained, the sequential position
is indicated by a number displayed on the unit front panel. The first unit
connected to the 1Q-203 is numbered 1.

IMPORTANT

For proper connection, firmly push the IQ interface cable into the
appropriate port until it clicks twice. Improper connection may cause
operation problems.

IQ interface cables are offered in 2.5-, 5-, and 8-feet lengths. For

proper operation, the IQ interface cables used in a system should
not be more than 12 feet.

Optical Test System 17



Installing and Connecting the 1Q-200 Hardware
Connecting 1Q-206 Expansion Units to an 1Q-203 Control Unit

1Q-203 Control Unit

/

Note: Actual ports on your unit may differ from those depicted in the illustration.

18 1Q-200



Installing and Connecting the 1Q-200 Hardware
Installing the IQ-206 Expansion Card

Installing the 1Q-206 Expansion Card

The 1Q-206 Expansion Card is available in two models: ISA and PCI. Both
cards provide the same functionality, but the installation procedure is not
exactly the same, as explained below. To determine the type of card you
have, see /Q-206 Expansion Card on page 6.

Minimum PC Requirements

The 1Q-206 Expansion Card has a power consumption of less than 200 mA.
The computer that will host the 1Q-206 Expansion Card must have the
following configuration:

» 486 DX4/75 with 16 MB of RAM (minimum)

» one free ISA expansion slot (AT 98-pin bus) or one free PCl slot
» Microsoft Windows 95/98 (other versions may not be supported)
» CD-ROM drive (local or via network)

Installing an ISA or PCI Card

To install the 1Q-206 Expansion Card in a computer,
1. If you have an ISA card, set the DIP switches on the card as explained
in Configuring DIP Switches on ISA Card on page 20.

Note: PCI cards are plug-and-play and require no DIP switch setting.

2. Power off the computer and unplug the AC cord.

3. Refer to the computer instruction manual to properly disassemble
the computer cover and access the expansion slots.

IMPORTANT

Handle the 1Q-206 Expansion Card as explained in Electrostatic
Discharge Precautions on page 10.

Optical Test System 19



Installing and Connecting the 1Q-200 Hardware
Installing the 1Q-206 Expansion Card

20

4. Firmly insert the 1Q-206 Expansion Card into any appropriate expansion
slot with due care and secure the card in place.

5. Reassemble the computer cover and tightly replace every screw.

6. Inthe case of a PCl card, turn on the computer and ensure the card is
correctly detected and its driver installed as explained in Adding a PCI
Card in Microsoft Windows on page 23.

7. Install the 1Q-200 Software (see Installing the IQ-200 Software on
page 27).

Configuring DIP Switches on ISA Card

Hardware configuration is accomplished through DIP switches on ISA
cards (see figures below). Use these DIP switches to set the I/O port
address and IRQ number of the card so they do not conflict with any other
card or component in your system.

3 4 5 6

1 2 3 4 5 6 7 8 T 2
o} © o}
N N
! _ ]
[ | |
\ \ /
I/O port address IRQ number These switches should always
(switches 1 to 5) (switches 6 to 8) be configured as shown

Take note of your DIP switch settings. You will be asked to enter these
settings at the end of the 1Q-200 Software installation, so the 1Q-200
Software can locate the IQ-206 Expansion Card within the system.

IMPORTANT

When setting DIP switches, the ON position is 0 and the OFF position
is 1.

IMPORTANT

The 6-switch bank must always be configured as shown.

1Q-200



Installing and Connecting the 1Q-200 Hardware
Installing the 1Q-206 Expansion Card

The /O port address is a hexadecimal number and must be any multiple of
020h within the range of 060h to 03C0Oh. The hexadecimal address is then
converted into binary code so the DIP switches can be set to the “1”
position (OFF) or to the “0” position (ON). The most commonly used

1/0O addresses are listed in the following table.

OEOh

300h 1 1

320h 1 1

0 T | 11
100h o |1 ]o0o| o] o
120h o [ 1 | o] ol 1

140h ol 1 1ol 11 o]
160h o | 1] o | 1|1
200h 1 ool ol o

2A0h rlo 1ol 1|
2C0h 1 o1 1o
o o o

ol o[ 1|

340h 1 %TFO‘L—T—W

Note: The recommended I/O port address is 300h. Other I/O ports may be set on
the card. If you are unable to determine the DIP switch settings for the
desired I/O port, contact EXFO.
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The possible IRQ numbers and their corresponding DIP switch settings are

listed in the table below.

IRQ5 0 0 0
IRQ7 1 0 0
IRQ9 0 1 0
IRQ10 1 1 0
IRQI11 0 0 1
IRQI12 1 0 1
IRQI15 0 1 1

Note: The recommended IRQ number for the IQ-206 Expansion Card is IRQ9.
If the host computer is equipped with a PS/2 mouse port, do not set the

1Q-206 Expansion Card to IRQI2.
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Adding a PCl Card in Microsoft Windows

Microsoft Windows will detect a new PCI card when you reboot your
computer and automatically offer you to install new drivers. You will need
access to a CD-ROM drive for this installation.

IMPORTANT

if your PC is not equipped with a CD-ROM drive, you could use the
Direct Cable Connection or your network to access another PC. For
help with these methods, see Accessing a Remote CD-ROM Drive with
the IQ-203 on page 79.

Note: The illustrations provided in this section were made with Windows 98. The
Wizard may look slightly different if you are using Windows 95, but the
procedure is similar.

To make Microsoft Windows correctly detect the new PCI expansion card,

1. After inserting the PCI card into the computer, turn on the computer.
When Windows is loaded, the Add New Hardware wizard will guide
you through the steps of card detection.

Add New Hardware Wizard ‘

This wizaid searches for new drivers for:

PCI Communication Device

A'device diiver s a software piogram thiat makes a
hatdware device work

2. Click on Next to start searching for drivers associated with the card.
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Add New Hardware Wizard

What doyouwant Wirdowi fo do?

& Bazich o the best drver for your device. |
fRecommended) .

€ Display akst of gl the deversin 2 speciic
localion, so vou can select the diiver you want:

3. Select the Search for the best driver option and click on Next.

Add New Hardware Wizard |

Windoues wil teaich Tor new divers in its diver ditabase
on your hard diive, and in any of the following selected
locations: Chck Next to start the search.

I~ Floppy dek tives

T COROM dive

4. Insert the CD-ROM that was included with your 1Q-206 Expansion Card
in your CD drive and check only the Specify a location box. Use the
Browse... button to locate it and click on Next to start searching.

IMPORTANT

EXFO recommends that you do not use the Floppy disk drives or
CD-ROM drive options. The Wizard may not recognize your drives
using these options.

5. When the card driver is found, click on Next again to start installing it.
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Connecting 1Q-206 Expansion Units to an
1Q-206 Expansion Card

Once installed into a PC, the 1Q-206 Expansion Card can control up to four
1Q-206 Expansion Units, which represents a total of 24 single-slot modules.
The necessary interface cable to connect an 1Q-206 Expansion Unit to
another 1Q-206 Expansion Unit or 1Q-203 Control Unit is supplied with the
1Q-206 Expansion Unit. Connections are shown on the next page.

Note: As the IQ-206 Expansion Units are daisy chained, the sequential position
is indicated by a number displayed on the unit front panel. The first unit
connected to the 1Q-206 Expansion Card is numbered 1.

IMPORTANT

For proper connection, firmly push the 1Q interface cable into the
appropriate port until it clicks twice. Improper connection may cause
operation problems.

IQ interface cables are offered in 2.5-, 5-, and 8-feet lengths. For

proper operation, the IQ interface cables used in a system should
not be more than 12 feet.
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o 1Q-206 Expansion Card
— installed into a PC

\

@
D

)
b2t U
.

V

Note: Actual ports on your unit may differ fromn those depicted in the illustration.

26 1Q-200



4 Installing and Configuring
the 1Q-200 Software

Installing the 1Q-200 Software

If you have purchased an 1Q-203 Control Unit, the 1Q-200 Software should
have been pre-installed at the factory. If you are to use the software with an
1Q-206 Expansion Card or if you ever need to reinstall it on your 1Q-203
Control Unit, use the CD-ROM provided with your 1Q-200 Optical Test
System. In either case, Microsoft Windows must already be installed in the
host unit.

IMPORTANT

if your PC is not equipped with a CD-ROM drive, you could use the
Direct Cable Connection or your network to access another PC. For
help with these methods, see Accessing a Remote CD-ROM Drive with
the 1Q-203 on page 79.

To install the 1Q-200 Software on an 1Q-203 or on a PC,

1. Insert the installation CD in your CD-ROM drive.

2. Select Run... from the Windows Start menu.

S Tye the name of a piogiam, foider, docisment, o Intemet

resource, and Windows will open # for you

Open: ]a'\selup exe -]

0K ] Cancel Browse ]

Type d:\setup (your drive letter may differ) in the Open text field.

4. Click on OK to launch the installation. The installation procedure first
detects the type of platform (PC or 1Q-203) on which you are installing
the 1Q-200 Software.

5. Close all programs, read the license agreement, and enter your name
and company, clicking on Next > after each step.
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6. In the Select Componenits step, choose the software components you
want to install on your 1Q-203 or PC.

Components

Sdmtwmwyoum cen
‘compoanents ot do nol wank (o nstel :

Space Ayaable.

6a. Check the boxes corresponding to the components to install.

» Program Files: necessary files to use the 1Q-200 Optical Test
System software. This option is mandatory.

» EXFO Screen Saver: a Microsoft Windows screen saver that
provides information about EXFO products and features.

» Manual and help files: instruction manuals of 1Q modules
and the 1Q-200 Optical Test System, in PDF format.

» Acrobat Reader: the Adobe Acrobat Reader software for
viewing the PDF instruction manuals.

IMPORTANT

Before installing Adobe Acrobat Reader, uninstall any previous version
from your PC or 1Q-203. If you uninstall the older version of Acrobat
Reader after installing the new one, both versions will be uninstalled.

6b. Keep the default destination folder (C:\IQ) as is, unless you really
need to change it.

6¢c. Click on Next > to move to the next step.
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7. Inthe Select GPIB Cornponents step, choose the type of GPIB material
you will use with your system.

Select Components [x]

i Select the GPIB 1ype. Lintess you have a GPIB-[of HPIB)
controlier card o1 the 10-203 installed in your compuier, it i

recommerided that pou select device.

" None

@ P18 Device Biivrs!

" GPB Controfier Configusation.

<Bock | hew> 30 Coeo |

7a. Select the radio button corresponding to your GPIB setup.
Examples are given below:

GPIB controller card GPIB device cond

15200 80198 witssrtat
m-,-umwm

» None: if you have no GPIB card in your system.

» GPIB Device Drivers: if you have a GPIB device card in your
system. This card allows your system to be remotely
controlled by another instrument.

» GPIB Controller Configuration: if you have a GPIB controller
card in your system. Use this card to remotely control other
instruments.

7b. Click on Next > to move to the next step.
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8. Verify the installation parameters and click on Next > to start installing
files. During the installation, you will be asked to configure the 1Q-200
Software to match your hardware. For details, see Configuring the
1Q-200 Drivers on page 31.

9. Read the information contained in the ReadMe.txt file. It provides
last-minute information about the software and module applications.
You can also find this file in the C:\IQ\Bin folder.

710. When the Adobe Acrobat Reader installation starts, you can choose to
skip it. If you need to install Acrobat Reader later, the installation files
are located on the 1Q-200 Optical Test System installation media.

11. When the installation is completed, click on OK when you are asked to
reboot your 1Q-203 or computer.

Setup Comptete

The setup bhas Brished coppéie s rito yous havd dive. Befoie
g the 10 spploabons. pox st Syteny.

% L

€ No Lwiisston my computds bnter

ook on Firksh to completa o sefip

12. If a Service Pack has been included with your shipment, you should
install it now. Service Packs provide the latest software updates.

Note: For more information about using the 1Q-200 Optical Test Systermn and its
software, see Using the 1Q-200 Optical Test System on page 35.
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Configuring the 1Q-200 Drivers

When running on a PC, the 1Q-200 Software must match the configuration
of the 1Q-206 Expansion Card. The configuration utility allows you to set the
1Q-200 Software drivers to the correct IRQ and base /O address (ISA
expansion card only) and to set the GPIB card parameters.

IMPORTANT

For the 1Q-200 Optical Test System to function properly, it is important
that no other device use the same IRQ and base 1/O address.

The 1Q-200 Software is configured through a small utility automatically
accessed at the end of the 1Q-200 Software installation. You can also access
this utility at any time after the installation.

To configure the 1Q-200 drivers with the IQ Configuration Tool,

1. Open the IQ Settings dialog box (shown below) by double-clicking on
the /Q Seftings icon at the bottom of the main window.

1G Settings [ =]
- Hapdwarg = - i il s s sl 13:Setlings
UT Disable Fiont Panet Koy
} LT T O AR Lights
‘ LT Save Configiiration on Exit
[ iopicalions Abvays 640 480

< Front 1 d
el ] 2 e ¢ Display
Cnend2, i i @ CRY

2. Inthe Hardware section, click on Config to display the 1Q Configuration
Tool, as shown below.
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figuration Tool

| 18 Configurstion Tool

are - Hardware Equipment
£ 10:203 Mainbrame e s
e BRI e Card

0-206.PC1 Expansion Card
« 184 Expansion Card Setings - . - ISA Expansion Card Seings
. YO AddressPange: . . DIP Switches Setings - 1O Address Range: |

Y0 Address Range: o 3 e i ! . ‘
i 2 =] [ 2a0n - 28F% e .
Cwme me: s
T =] . o {ira 05 «i

The hardware equipment (1Q-203 Control Unit or 1Q-206 Expansion
Card) should be automatically detected.

IMPORTANT

When running on an 1Q-203 Control Unit, the 1Q-200 Software
automatically configures itself to the default settings. In this case,
you should not change the parameters in the IQ Configuration Tool.

3. Ifyou are using an ISA expansion card, ensure that the parameters in
the ISA Expansion Card Settings group box match the I/O address
range and IRQ you have previously set on the card itself. The DIP switch
illustration adapts to your choices.

4. Ifyouplan to use a GPIB device card, check the Use GPIB Interface box
and specify the I/O Adress Range and the IRQ to use.

5. Click on OK to accept the changes and exit the 1Q Configuration Tool,
or click on Cancel to exit without applying the changes.

6. Restart your systemn to make the changes effective.
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Uninstalling the 1Q-200 Software

To uninstall the 1Q-200 Software,

1.
2.

Optical Test System

In the Windows Start menu, select Control Panel.

Select the Add/Remove Programs icon to display a list of all the
software installed on your unit.

Select the one(s) you wish to remove and click on Remove. You may
be asked to reboot your computer after the operation.
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5 Using the 1Q-200 Optical Test
System

Getting Started with the 1Q-203 Control Unit

Before powering on the 1Q-203 Control Unit and 1Q-206 Expansion Unit,
EXFO recommmends that you carefully read the previous sections of this
instruction manual to ensure that

» you comply with the safety precautions, power requirements, and
other safety instructions given in Safety Information on page 9.

» you have connected the units together properly via the IQ interface
cable as specified in Connecting 1Q-206 Expansion Units to an 1Q-203
Control Unit on page 17.

WARNING

Any failure to respect the safety and operation guidelines given in this
manual may void the product warranty and could result in product
damage or personal injury.

To power on the 1Q-200 Optical Test System,

1. Make sure that all units are properly connected.

2. Insert the desired modules into the 1Q-203 Control Unit and 1Q-206
Expansion Units, as explained in Inserting Modules in the 1Q-203 or
1Q-206 on page 39.

CAUTION

Never insert a module while the 1Q-203 Control Unit or 1Q-206
Expansion Unit is powered on. This will result in immediate and
irreparable damage to the module and the 1Q-203 or 1Q-206.
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3. Power on the 1Q-206 Expansion Unit(s) by pushing the ON/OFF button
located in the bottom left corner of each unit.

IMPORTANT

Modules inserted in 1Q-206 Expansion Units must be electrically
powered for the 1Q-200 Software to recognize them. Therefore,
always power on the 1Q-206 Expansion Units before powering on the
1Q-203 Control Unit and loading the 1Q-200 Software.

4. Power on the 1Q-203 Control Unit by pushing the ON/OFF button
located in the bottom left corner of the unit.

While booting up, the 1Q-203 Control Unit performs the following
operations in sequence:

» scans the hard disk for errors if the 1Q-203 was not properly
powered off. See Scanning Hard Disks for Errors on page 61.

» loads the Microsoft Windows operating system;

» loads the 1Q-200 Software and opens the 1Q-200 Optical Test
System window;

» performs a self-test to demonstrate that communication has been
established. During this test, the LED push buttons of all IQ
meodules light up in sequence.

For more information about the use of the IQ-200 Software, see
Understanding the 1Q-200 Software on page 41. If you encounter any
problems, see Maintenance and Troubleshooting on page 59.
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Getting Started with the Expansion Card

Before powering on the PC with an 1Q-206 Expansion Card and the
1Q-206 Expansion Units, EXFO recommends that you carefully read the
previous sections of this instruction manual to ensure that

» you comply with the safety precautions, power requirements, and
other safety instructions given in Safety Information on page 9.

» you have connected the units together properly via the 1Q interface
cable as specified in Connecting 1Q-206 Expansion Units to an 1Q-206
Expansion Card on page 25.

WARNING

Any failure to respect the safety and operation guidelines given in this
manual may void the product warranty and could result in product
damage or personal injury.

Note: Forinformation about using the PC hosting the 1Q-206 Expansion Card,
refer to the instruction manual that came with the PC.
To power on the 1Q-200 Optical Test Systeml,
1. Make sure that all units are properly connected.

2. Insert the desired modules into the 1Q-206 Expansion Units, as
explained in Inserting Modules in the 1Q-203 or 1Q-206 on page 39.

CAUTION

Never insert a module while an 1Q-206 Expansion Unit is powered on.
This will result in immediate and irreparable damage to the module
and the 1Q-206.
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3. Power on the 1Q-206 Expansion Unit(s) by pushing the ON/OFF button
located in the bottom left corner of each unit.

IMPORTANT

Modules inserted in 1Q-206 Expansion Units must be electrically
powered for the 1Q-200 Software to recognize them. Therefore,
always power on the 1Q-206 Expansion Units before loading the
1Q-200 Software.

4. Power on the computer hosting the 1Q-206 Expansion Card and load
Microsoft Windows (it is usually loaded automatically).

5. From the Windows Start menu, select Prograrmms > EXFO > 1Q Shell.

As the 1Q-200 Software loads, it performs a self test to demonstrate that
communication has been established with 1Q modules. During this
test, LED push buttons of all 1Q modules light up in sequence.

For more information about the use of the 1Q-200 Software, see
Understanding the 1Q-200 Software on page 41. If you encounter any
problems, see Maintenance and Troubleshooting on page 59.
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Inserting Modules in the 1Q-203 or 1Q-206
CAUTION

Never insert a module while the 1Q-203 Control Unit or 1Q-206
Expansion Card is powered on. This will result in immediate and
irreparable damage to the module and the 1Q-203 or 1Q-206.

To insert an IQ module in the 1Q-200 Optical Test System,

1. Exit the 1Q-200 Software and power off the 1Q-203 and IQ-206. If you are
controlling modules from a PC, you do not need to turn the PC off.

2. Remove the protective cover of any unused module slot, by pulling the
bottom of the cover and removing it completely.

R

/

Bottom of
protective cover

3. Insert the IQ module into the empty slot. The 1Q-203 or 1Q-206 will
automatically recognize which slot you selected.

IMPORTANT

Be sure to insert the module all the way to the back of the 1Q-203 or
1Q-206 so that the backplane connectors are properly mated. The
modaule is correctly inserted when its front panel is flush with the
1Q-203 or 1Q-206 front panel.

Optical Test System 39



Using the 1Q-200 Optical Test System
Removing Modules from the 1Q-203 or 1Q-206

Removing Modules from the 1Q-203 or 1Q-206
CAUTION

Never remove a module while the 1Q-203 Control Unit or the 1Q-206
Expansion Unit is powered on. This will result in immediate and
irreparable damage to the module and the 1Q-203 or 1Q-206.

Depending on the locking system with which the module is designed,
there are two ways to remove an 1Q module from the 1Q-203 Control Unit
or 1Q-206 Expansion Unit.

1. Exit the 1Q-200 Software and power off the 1Q-203 and 1Q-206. If you are
controlling modules from a PC, you do not need to turn the PC off.

2. Place your fingers under the module front panel.
OR

Push up the locking mechanism under the module front panel,
as shown below.

Locking
mechanism

3. Firmly pull the module outward.

4. Put one of the supplied protective covers over the empty slot to prevent
dust from entering the module housing.
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Understanding the 1Q-200 Software

The 1Q-200 Software main window is illustrated below.

351q-200 Optical Test System

He Diplay Bun Window Heb ‘ EE "] Menu
bar
Module
application
icons
1Q Settings u
icon —]
o0 frae B
048
e
’ T T D Status
| } | Local 142 —
Closed Application Minimized Application
Red icon Green icon
with a frame. with no frame.

The 1Q module icons represent the modules detected by the 1Q-200 Optical
Test System at power up.

The module icon indicates the type of module and its position in the 1Q-203
Control Unit or 1Q-206 Expansion Unit. The position is represented by

» a number, telling in which unit the module is inserted (0 for the 1Q-203
Control Unit and 1 to 4 for the 1Q-206 Expansion Units).

» a letter, telling which slot the module occupies in the unit (A to C for
the 1Q-203 Control Unit and A to F for the 1Q-206 Expansion Units).
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Using the Front Panel Mouse

The front panel mouse operates as a standard computer mouse.

Hold Button
To initiate mouse dragging.
°o°\ Arrow Buttons

o To move the mouse pointer.
O O Right Button
To display contextual menus.
l Left Button

To select elements.

To drag elements with the front panel mouse,
1. Using the arrow buttons, position the cursor on the selection.

2. Activate the mouse drag function by pressing the button.

3. Drag the selection to the desired position using the arrow buttons.

4. Press on the left button to drop the selection and deactivate the
mouse drag.

42
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Using the Front Panel Keys

The [Q-203 front panel keys may be used as hardware keys, as described:

When another Windows application runs, return to the 1Q-200 Software.

When an IQ application is open, display its monitor window.

When several monitor windows are open, switch between them.

Y Y vYYy

When all IQ-200 front panel lights are turned off (see Activating and
Deactivating the Front Panel Lights on page 46), return to the normal LCD
and LED displays.

Move between window items (as a tab).

Scroll upwards in a list box.

Select a check box option.

Scroll downwards in a list box.

EEEEE
YIY|IY|VY|Y

Select an object or an option (as Enter or Return).

You may also use the keys to activate the software buttons aligned with
them on the left side of an 1Q application main window, as shown below:

: 10-1101 Si Power Meter {1-A)
Sie Dy Hop

—> » @li Chinnal Bcquisition Graph _J
l | > Ret i Chennel SamplingRats©
Channel 1 L 1o

—> as ql Ref Offget
: @ - éuinnm Bl 5 0800 g F_‘:\:”T.—_

e 20.90
4’6 Mg . "
@—> Fro A O ok o

Use the @

key to activate
or deactivate
the software
buttons.
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Typing Values with the Software Keypad

When an external keyboard is not available, you can use the numeric or
alphanumeric software keypad to enter data in the 1Q-200 Software.

To enter values using the software keypad,

1. Double-click in the box or field where a value must be entered to
display the appropriate keypad window.

To switch between positive

. To erase a digit
and negative values 9

To cancel data entry

To enter time values

To save the value and
return to previous window

H ‘ g l : } e To erase a character

2 : ! i } i To move to next line
' in a multiline field

i
| SR cancel data entry

To save the text and
close the keypad

2. By clicking on the buttons, type the text or numbers you want. You may
use the special keys shown in the above illustration while typing.

3. Save the value you typed or leave the keypad without saving the value.
Keys are described in the above illustrations.
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Customizing the 1Q-200 Optical Test System

Selecting an LCD or CRT Screen

You can select to have the software displayed on the built-in screen of the
1Q-203 Control Unit or on an external monitor.

To select the type of screen,

1. Open the IQ Settings dialog box (shown below) by double-clicking on
the /Q Settings icon at the bottom of the main window.

iQ Settings [=I=]
[ 1 Settings - e il 5

I~ Disoble Fioit Pl Keys 3

I Torn Off AB Lights

1 Save Configuration on Exit

i 4 i 540% 480
~ Front panel fouss speed e IM

Interyd 1 | + /Djsplaywwh» s
teivat2 i : o & Rt

2. Select the screen type in the Display section.
» LCD: built-in screen of the 1Q-203 Control Unit.
» CRT: external monitor, if one is connected.

3. C(lick on OK to accept the changes.

Note: You can also select the desired screen type from the Display menu.
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Note:

Note:

46

Activating and Deactivating the Front Panel Lights

You can switch off all lights on all screens and module lights on the 1Q
components. This is useful when you need to use the 1Q-200 Optical Test
System in a dark environment.

Floppy disk access light and hard disk LED may sometimes illuminate.

To activate or deactivate the front panel lights,

1. Open the IQ Settings dialog box (shown below) by double-clicking on
the JQ Settings icon at the bottom of the main window.

2. Check the Turn Off All Lights box.
3. Click on OK to accept the changes.

Once screens and lights are deactivated, press the front panel key to
re-activate them.

You can also activate or deactivate the front panel lights directly from the
Display menu.
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Activating and Deactivating the Front Panel Keys

You can disable all front panel keys on your 1Q-203 Control Unit to deny
user intervention while your system is running.

To activate or deactivate the front panel keys,

1. Open the IQ Settings dialog box (shown below) by double-clicking on
the IQ Settings icon at the bottom of the main window.

1Q Settings 1=}

' Save Configuration on Exit
¥ Appleations Always 6402 480

Dol - Al Display
Cinevd2 ] e o

2. Check the Disable Front Panel Keys box.
3. Click on OK to accept the changes.

To activate the keys once they are deactivated, uncheck the box in the
1Q Settings dialog box.

Note: You can also activate or deactivate the front panel keys directly from the
Display menu.
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Note:

Changing Mouse Tracking Speed

You can set the delay for the first and second increase in tracking speed
on your front panel mouse.

This feature is enabled in non-Pentium systems only.

To change the front panel mouse speed,

1. Open the /Q Settings dialog box (shown below) by double-clicking
on the /Q Settings icon at the bottom of the main window.

| T SaveConipaston ot

| I Apphcation Slwags 640 x4

2. Move the scroll bars for Interval I or Interval 2.

3. Click on OK to accept the changes.

Selecting and Configuring a Printer

The printer selection procedure for the IQ-200 Optical Test System is the
same as for any Windows-compatible software. Refer to the Microsoft
Windows documentation for further details.
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Renaming Modules

You can customize the text appearing in the title bar of a module
application. This may be useful when you use several similar modules.

To modify the module name,

1. Open the IQ Settings dialog box (shown below) by double-clicking on
the /Q Settings icon at the bottom of the main window.

IQ Settings [=]x]
5 o Y 3 |u swm ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ w

I Dicable Front Panel Kegs |

Tum DIt A Lighis j

1™ Save Confichyation on Exi i

" o Abvays 5405480

i Front parslmovsse spead. - o 5 & i" Wm = m x L
| dnevd2 s EELIE ity & CRT %

=]

2. Click on the ID button in the Hardware section to display the Module
Identification dialog box (shown below).

Hodule {dentification
Tie

0-A 1Q-2123BLC 13101550 nm Laser

0K ! Cancel

3. Select a module slot in the Module list. When you do so, the module’s
current title appears on the right.

4. Change the current title using one of the following methods:
» Type a new name or change the current name in the title box.

» Click on Default to return to the factory-defined name.

5. Click on OK to accept the changes.
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Setting the Display Resolution for Module
Applications

You can set all module applications to automatically launch in
640 x 480 display resolution. Otherwise, applications will launch in the
default resolution of your PC.

To ensure that all module applications start in 640 x 480 resolution,

1. Open the IQ Settings dialog box (shown below) by double-clicking on
the IQ Settings icon at the bottom of the main window.

1Q Settings v [~}

} (EF..08

nisival2 FAlT 9 ot

2. Check the Applications Always 640 x 450 box.
3. Click on OK to accept the changes.
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Customnizing the 1Q-200 Optical Test Systern

Opening and Saving a Software Configuration

Configuration files allow you to store commonly used parameters to reuse
them later. Parameters that are saved include:

» position and size of monitor windows and module icons

» parameters defined in the IQ Settings dialog box

To open a previously saved configuration,

1. Select Open Config... from the File menu.

2. Inthe Open config dialog box, select a .CFG file.

3. Clickon OK.

To save the current configuration at any time,

1. Select Save Config... from the File menu.

2. Inthe Save config dialog box, name your configuration (.CFG) file.

3. Click on OK.

To automatically save the current configuration when exiting the software,
1. Open the IQ Settings dialog box (shown below) by double-clicking on

the IQ Settings icon at the bottom of the main window.

IO Settings B
+Hajdware 1 Settings
! (I Disable Ficrt Pariel Kot
T Twa QR ARLiGh

. Frant panel fouss speed -y

i Interval 1 :J J ?Dlxpla;; ;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;; .
LLCER R =2 E ~un & 'cAt

Check the Save Configuration on Exit box.

Click on OK to accept the changes.
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Starting and Using Module Applications

The main window of a module application contains all module operation
commands. As an example, the main window of the 1Q-1100 Power Meter

application is shown below:

1Q-1101 Si Power Meter {1-A)

oo s o s e

Channel Acquisition

Q_raph __J

{ Channe

: ‘Channel 1

~Sampling Rate—

i

1.0/sec

.90

: e%me run ; Local ¢ D9:69

The 1Q-200 Software is based on the Microsoft Windows operating system,
so most module applications use standard Windows elements, such as:

[Acquisition Setup

Mode - Sampling Bate

Radio buttons

List boxes

—— « [Timed © Trgger © Delay [1DJsec 7|

Provide a choice between two - Trigger “Delay

or more options, from which fo N it dBm {@%ﬁz 18

you may select only one. B N
FRa -Durahun
: g {m:e{z B | e

LRy ¥ +{0000:00:10

Single value with a pull-down
arrow. Contains many values,
from which you select one.

Edit boxes

Data File o i ;

Software buttons ACQPMOQPAT: “ Eile Name
toinitiate an a‘ctlon or open star : no
a secondary dialog box. :

52

Data display and entry box
that contains a value you
may modify.
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Starting and Using Module Applications

Note: For details about a particular module application, refer to the instruction
manual of the IQ module. A list of available 1Q modules is given in 1Q
Modules and Typical Applications on page 71.

Starting the Module Application

To open an IQ module application and display its main window,

» Double-click on the desired module icon along the bottom of the IQ
Software main window.

Module
icons

[0, o e A e

8o il : s -

13 Settings {131513 (1A} 1R-2T02BLE {15320 1.0} 1Q-91048
18] 0}
g, s Locaiw rﬁwzzb.
OR

» Press the LED button on the module front panel.

Note: Module applications may be set to automatically launch in 640 x 480
display resolution. For details, see Setting the Display Resolution for Module
Applications on page 50.

Exiting the Module Application

To exit a module application,

» Click on x]in the top right corner of the application main window.
OR

» Click on x]in the top right corner of the module monitor window.
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Displaying the Module Monitor Window

The monitor window of a module is a small window containing basic
operation information for quick reference. It is ideal for use in tile format
on the screen (27 monitor windows can be viewed simultaneously).

The monitor window for the 1Q-1100 Power Meter is shown below:

10-2102BLC 1310 nm Laser {1-B) e

1310.0nm  Status; OFF
0.0dB  NoMod.

Note: Refer to the instruction manual that came with your particular module for
further information about its monitor windouw.

Opening a Monitor Window
To open the monitor window of a module, use one of the following ways:

» In the main window of the module application, select Monitor from the
Display menu.

» Minimize the module application main window by clicking on E in
the upper right corner.

» Wrhile the main window of the module application is displayed,
press the LED button on the module front panel.
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Displaying the Module Monitor Window

Arranging Monitor Windows on the Screen

To arrange all open monitor applications on the screen in a standard
Windows cascade format, select Cascade from the Window menu.

To arrange all open monitor applications on the screen in a standard
Windows tile format, select Tile from the Window menu.

Showing or Hiding the Function Button Keypad

You can right-click on the required monitor window to access the function
button keypad as shown below. Clicking anywhere outside the function
button keypad will hide the latter.

£11Q-200 Opticat Test System [ 15 ]
Ele. Display - Bun’' Wodow Help

1Q-21028LC 1310 nm Laser (1-8) [—]]

13100nm  Sahus; OFF
0.0dB NoMod

&t
3-21028LC
+B)

1613{1-4) PO-5§2¥) 1)

Local 1 16:24

:

Closing the Monitor Window

To close the monitor window and return to the module main window,
double-click anywhere in the monitor window.
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Controlling the 1Q-200 Remotely

The status bar indicates the module control status as described in the
following table. For more information about remotely controlling the 1Q-200
Optical Test System, refer to the GPIB and Application Development Guide.

e -
- g

Local |The 1Q-200 Optical Test System is controlled locally.

Remote |The IQ-200 Optical Test System is controlled remotely but

local commands can still be used.

Lockout

The 1Q-200 Optical Test System is controlled remotely only.

To use the SCPI Manager utility, select SCPI Manager from the Run menu.

For details about this utility, refer to the GPIB and Application Development
Guide.

Exploring Drive Contents and Running
External Software

To explore the contents of your local or network drives and run external
software, use one of the following options from the Run menu:

Explorer Opens Windows Explorer.
Drive A:

Gives access to drive A: through Windows Explorer.

Drive C:

Gives access to drive C: through Windows Explorer.
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Getting Help in the 1Q-200 Software

The following table describes the possible ways to obtain help or
inforrnation from the Help menu:

L ; . b .
Online Manual |Opens this instruction manual in PDF format. You
need to have Adobe Acrobat Reader installed on
your 1Q-200 Optical Test System.

Tip of the day |Displays the Tip of the Day dialog box.

About... Displays a dialog box containing the following
information:

» 10Q-200 Software version

» contact information for technical support
» available 1Q-203 systemn memory (RAM)
»

remaining disk space on current drive
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Powering the 1Q-200 Optical Test System Off
IMPORTANT

Before powering off the 1Q-203 Control Unit and 1Q-206 Expansion
Units, you must exit the 1Q-200 Software and shut down Microsoft
Windows.

To exit the 1Q-200 Software and Microsoft Windows,

1. In the 1Q-200 Optical Test System main window, select Exit from the
File menu.

OR
Click on x| in the top right corner of the main window.

An information window will appear indicating a subsequent
deactivation of all module applications.

2. Choose OK to close all IQ module applications.
3. Shut down Microsoft Windows from the Windows Start menu.

To power off the 1Q-203 Control Unit or 1Q-206 Expansion Units, push the
ON/OFF button located in the bottom left corner of each unit.
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6 Maintenance and
Troubleshooting

The 1Q-200 Optical Test System family components have been designed to
require a minimum of maintenance and provide reliable operation for
many years. In addition, the 1Q-203 has the same characteristics as a
computer, therefore, similar care should be taken.

Cleaning the 1Q-203 Control Unit and 1Q-206
Expansion Unit

To help ensure long, trouble-free operation,
» keep the unit free of dust;

» be careful not to spill liquids into the unit. If the unit does get wet,
turn the power off inmediately, and let the unit dry completely before
turning it on again; and

» clean the unit with a slightly damp (with water) cloth.

To prevent dirt and dust from entering the module housing, replace
the protective cover plate when a slot is not in use.
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Replacing the Fuses

The 1Q-203 Control Unit and 1Q-206 Expansion Unit each contain two 250 V,
3.15 A (0.197 x 0.787 inches / 5 x 20 mm) slow blow fuses. The fuse holder
is located on the unit back panel, just beside the socket.

To replace the fuses,
1. Unplug the power cord from the unit.

2. Pull the fuse holder out.

4. Ensure that the fuses are firmly in the holder prior to reinsertion.

Firmly push the holder back into place.
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Defragmenting Drives and Files

Over time, as applications read, write, and delete files, information stored
on the 1Q-203 Control Unit hard disk may become fragmented. Basically,
fragmented files are longer to access and read than unfragmented files. To
reorganize the files on the disk and, thus, optimize disk performance, it is
recommended to perform a defragmentation at least weekly.

To initiate a defragmentation, from Windows Explorer go to CAWINDOWS
and double-click on the file DEFRAG.EXE. For more information on
ScanDisk, refer to the Microsoft Windows documentation.

Scanning Hard Disks for Errors

Microsoft ScanDisk is a program used to detect errors on a computer drive.
Once found, the erroneous files are fixed and saved in the drive’s root
directory, under the name «FILEOO0O.CHK », «FILEOOQ1.CHK »,
«FILE0O002.CHK », etc.

In the Windows environment, a ScanDisk is automatically performed at
power up every time the 1Q-200 Optical Test System has not been properly
shut down. It is recommended to verify the «.CHK» files from time to time
and delete the needless ones to free disk space.

Every time a ScanDisk is performed, the results of the disk analysis are
stored in the SCANDISK.LOG file. The SCANDISK.LOG is used to identify
any erroneous files detected at startup. It is recommended to occasionally
delete this file to prevent it from wasting disk space. For more information
on ScanDisk, refer to the Microsoft Windows documentation.
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Troubleshooting the 1Q-203 Control Unit and
1Q-206 Expansion Unit

o o 5 S -

1Q-203 or 1Q-206 does
not power ON.

AC power not applied.

Verify AC power cord connection,
then power on 1Q-203 or 1Q-206.

Verify the fuses (see Replacing the

display on 1Q-203

Fuse blown Fuses on page 60).
. Press the front panel key, or
LCD/CRT display not . NG
Blank LCD/CRT activated select an LCD/ CRT display in Display

menu when LCD/CRT lights up.

External display not on

Turn on external display.

Panel keys, mouse,
and/or keyboard do
not respond.

No communication
between
keys/mouse/keyboard
and computer

Power OFF 1Q-203 and 1Q-206
Expansion Units and secure 1Q
modules in place as well as verify
mouse, keyboard, and all cable
connections, then power on 1Q-203.

Improper color scheme

Exit the 1Q-200 Software and access
the Windows Control Panel.
Double-click on Display. In the

Unit sequential
position display
indicates "E".

LCD flickers settin Display Properties window, choose
s the Appearance tab. From the
Scheme list, select High Contrast
White.
1Q-206 Expansion 1Q-206 Expansion Unit Power OFF 1Q-203 and 1Q-206;

not connected to 1Q-203
or to 1Q-206 Expansion
Card.

properly connect interface cable;
then power on 1Q-206, followed by
1Q-203.
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Troubleshooting the 1Q-206 Expansion Card

Troubleshooting the 1Q-206 Expansion Card

e Caus

1Q-200 Software
does not detect
1Q modules
installed in an
1Q-206 Expansion
Unit.

The 1Q-206 Expansion
Unit is not powered on.

The modules are not
properly inserted into
their slot.

The IQ interface cable
is not properly
connected.

The card is not
properly connected.

The 1Q-206 Expansion
Card conflicts with
another card installed
in the computer.

1. Power off the PC running the 1Q-200
Software and power off the
1Q-206 Expansion Unit.

2. Make sure the modules are properly
inserted into their slots.

3. Make sure the IQ interface cable is
properly connected.

4. Make sure the 1Q-206 Expansion
Card is properly installed.

5. Make sure other cards installed in
the computer do not conflict with
the 1Q-206 Expansion Card.

6. Power on the 1Q-206 Expansion Unit
and load the 1Q-200 Software.

PC hosting the
1Q-206 Expansion
Card does not
boot.

Mouse or
keyboard not
responding.

1Q-206 Expansion Card is
not properly installed.

Remove the card from the host
computer, clean the edge connectors
of the card, then reinstall the card as
described in Installing the 1Q-206
Expansion Card on page 19.

Address conflict

Verify that 1/O ports address and IRQ of
other cards do not conflict with that of
1Q-206 Expansion Card (see Configuring
DIP Switches on ISA Card on page 20).

Address conflict

Verify that 1/O ports address and IRQ do
not conflict with that of 1Q-206
Expansion Card (see Configuring DIP
Switches on ISA Card on page 20).
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Transportation and Storage

Maintain a temperature range within specifications when transporting or
storing the unit. Transportation damage can occur from improper handling.
The following steps are recommended to minimize the possibility of
damage:

» Pack the unit in the original packing material when shipping.

» Store unit at roorn temperature in a clean and dry area. Avoid high
humidity or large temperature fluctuations.

» Keep the unit out of direct sunlight.

» Avoid unnecessary shock and vibration.

Contacting the Customer Service Group

If you encounter any difficulty while using this product, please call EXFO at
one of the offices listed below. Our Customer Service Group is available in
North America from 7:30 a.m. to 8:00 p.m. (Eastern Time), Monday to

Friday.

EXFO Electro-Optical Engineering Inc. 1 800 663-3936 (USA and Canada)
(Corporate Headquarters) Tel.: (418) 683-0211

465 Godin Avenue Fax: (418) 683-2170

Vanier (Quebec) GIM 3G7 support@exfo.com

CANADA www.exfo.com

EXFO Europe
Centre d’Affaires Les Metz

100, rue Albert Calmette Tel.: +33.1.34.63.00.20
78353 Jouy-en-Josas Fax: +33.1.34.65.90.93
FRANCE
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7 Technical Specifications

Electrical Specifications

Supply voltage 100 to 240 VAC | 100 to 240 VAC —

Line frequency 50 to 60 Hz 50 to 60 Hz —_

Maximum input current 1.5A 3.0A —

Fuse 250V, 3.15A 250V, 3.15A —
slow blow slow blow

Installation overvoltage category

11

11

Power

5VDC

<200 mA

Mechanical Specifications

Number of slots 6 —
Width: 14.257/36 cm | Width: 14.25”/36 cm | Thickness: 0.8"/2.0 cm
Dimensions Height: 5.757/14.5 cm | Height: 5.757/14.5 cm | Height: 4.87/12.2 cm
Length: 127/30.5cm | Length: 127/30.5 cm | Length: 6.57/16.4 cm
LCD (VGA) Width: 57/12.5 cm — —
monitor Height: 3.5”/9 cm — —
Weight 11.7 1b/5.3 kg 7.71b/3.5kg —
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Environmental Specifications

Environmental Specifications

Operating temperature

32°to 122°F
(0° to +50°C)

32°to 131°F
(0°to +55°C)

32°to 131°F
(0° to +55°C)

Storage temperature -4° to 140°F -40° to 158°F -4° to 140°F
(-20° to +60°C) (-40° to +70°C) (-20° to +60°C)
Relative humidity 80% 95% 95%

(non-condensing)

(non-condensing)

(non-condensing)

Maximum altitude

6000 ft./2000 m

6000 ft./2000 m

Pollution degree

2

2
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8 Warranty

General Information

\

Yy

EXFO Electro-Optical Engineering Inc. (EXFO) warrants this equipment
against defects in material and workmanship for a period of two years
from the date of original shipment. EXFO also warrants that this equipment
will meet applicable specifications under normal use.

During the warranty period, EXFO will, at its discretion, repair, replace,
or issue credit for any defective product. This warranty also covers
recalibration during a two-year period if the equipment is repaired or if
the original calibration is erroneous.

IMPORTANT

The warranty can become null and void if

the equipment has been tampered with, repaired, or worked upon by
unauthorized individuals or non-EXFO personnel.

the warranty sticker has been removed.

case screws, other than those specified in this manual, have been
removed.

the case has been opened, other than as explained in this manual.
the equipment serial number has been altered, erased, or removed.
the equipment has been misused, neglected, or damaged by accident.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES EXPRESSED,
IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. IN NO EVENT SHALL EXFO BE LIABLE FOR SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES.
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Liability

Liability

EXFO shall not be liable for damages resulting from the use of the
purchased product, nor shall be responsible for any failure in the
performance of other items to which the purchased product is connected
or the operation of any system of which the purchased product may be a
part.

EXFO shall not be liable for damages resulting from improper usage or
unauthorized modification of the product, its accompanying accessories
and software.

Exclusions

EXFO reserves the right to make changes in the design or construction of
any of its products at any time without incurring obligation to make any
changes whatsoever on units purchased. Accessories, including but not
limited to fuses, pilot lamps, and batteries used with EXFO products are not
covered by this warranty.

Certification

EXFO certifies that this equipment met its published specifications at the
time of shipment from the factory.

Service and Repairs

68

EXFO commits to providing product service and repair for five years after
the date of purchase.

For service or repair of any equipment, follow the procedure below:

1. Call EXFO Customer Service Group. Support personnel will determine
if the equipment requires service, repair, or calibration.

2. If the equipment must be returned to EXFO or an authorized service
center, support personnel will issue a Return Merchandise
Authorization (RMA) and an address for return.

1Q-200



Warranty
Service and Repairs

IMPORTANT

Never send any unit or accessory back to EXFO without a Return
Merchandise Authorization (RMA).

3. Ifthe unit has an internal storage device, do a backup of your data
before sending the unit for repairs.

4. Pack the equipment in its original shipping material. Be sure to include
a statement or report fully detailing the defect and the conditions under
which it was observed.

5. Return the equipment, prepaid, to the address given by the support
personnel. Be sure to write the RMA on the shipping slip. EXFO will
refuse and return any package that does not bear an RMA.

Note: A test setup fee will apply to any returned unit that, after test, is found to
meel the applicable specifications.

After repair, the equipment will be returned with a repair report. If the
equipment is not under warranty, the customer will be invoiced for the cost
appearing on this report. Return-to-customer shipping costs will be paid by
EXFO for equipment under warranty. Shipping insurance is at the
customner’s expense.
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A 1Q Modules and Typical
Applications

List of IQ Modules

The following table lists the 1Q modules available when this instruction
manual was printed. To obtain the most recent information or for further
details, please contact EXFO.

NlQ-] 100 |Power Meter (single channel) 1Q-5100B |Polarization Contfoller
1Q-1200 [{4-Channel Power Meter 1Q-5240 |Optical Spectrum Analyzer
1Q-1500 [Calibration Power Meter 1Q-5310 |Wavelength Meter
1Q-1600 |High-Speed Power Meter Series | 1Q-5320 [Multi-Wavelength Meter

(1, 2, or 4 channels)
1Q-2100 |Light Source 1Q-5500 |PMD Analyzer
1Q-2300 |ASE Broadband Source 1Q-6100 |Erbium Doped Fiber Amplifier
1Q-2400 {WDM Laser Source 1Q-7200 |Multimode OTDR Series
1Q-2600 |Tunable Laser Source 1Q-7300B |Singlemode OTDR Series
1Q-2600B | Tunable Laser Source 1Q-7400B |Singlemode OTDR Series
1Q-3100 |Variable Attenuator 1Q-7500B |Singlemode OTDR Series
1Q-3200 |Return Loss Meter 1Q-9100 |Fiber-Optic Switch
1Q-3300 |Variable Reflector 1Q-9600 |Utility Module
1Q-3400B | PDL/OL Analyzer 1Q-9700 |Passive Depolarizer
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Typical Applications for IQ Modules

Typical Applications for IQ Modules

The following table gives some typical test applications and the necessary

1Q modules.
fnsertion loss XIX[X]X|X X X X[ X
Optical return loss X1X|X XX
Polarization dependant loss X X XX
Isolation and crosstalk X XXX
Polarization mode dispersion X X X

L S

Insertion loss vs. wavelength X XI1X[X|X

X
Optical return loss vs. wavelength XX XX X
Polarization dependant loss x| x X X | X
vs. wavelength
Isolation and crosstalk vs. wavelength | X | X | X [ X | X X
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Noise simulation X X
Tx-Rx X X X X | X
Bit error rate (BER) X[ X|X]|X XI1X|X

EDFA
Photodetector X X X X1 X
Laser diode X | XXX XX | XX

Calibration X XXX X

Fiber characterization X XIX| XX
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B Using the 1Q-9600 Utility
Module

The 1Q-9600 Utility Module provides a secure, standardized way of
integrating components such as couplers, isolators, filters, and Bragg
gratings into the 1Q-200 Optical Test System. Without such a module, these
passive optical elements would end up loose on your workbench. This can
cause damage or affect their adjustment.

The 1Q-9600 Utility Module consists of an empty I1Q module casing that fit
into your 1Q-203 Control Unit or 1Q-206 Expansion Unit to house
non-electrical elements (no electrical connections are provided).

The 1Q-9600 Utility Module comes in either single-slot size (IQ-9601) or
double-slot size (1Q-9602). The amount of material supplied with the utility
module depends on the configuration, but it usually includes

» adhesive tape
» tie wraps

» splice holder
» connectors

Use the exploded views presented in this section as a reference
for disassembling and reassembling the utility modules.
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Using the 1Q-9600 Utility Module
Exploded View of Single-Slot Utility Module

Exploded View of Single-Slot Utility Module
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Using the 1Q-9600 Utility Module
Exploded View of Double-Slot Utility Module

Exploded View of Double-Slot Utility Module
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C Accessing a Remote CD-ROM
Drive with the 1Q-203

To access an external CD-ROM drive with your 1Q-203 Control Unit, you
may use either a PC accessed through a network or one connected directly
to your 1Q-203. Using the network is easier if you have access to it from
your 1Q-203, but both methods are explained in this section.

Note:

You may also use a portable CD-ROM drive connected to your 1Q-203.

In this case, refer to the drive documentation for help or instructions.

Sharing the CD-ROM Drive from the PC

The first thing you must do to access files and applications on the CD-ROM
from your 1Q-203 is to share the CD-ROM drive on the PC, no matter which
method you use to connect the PC to your 1Q-203.

To share the CD-ROM drive,

1. In Windows Explorer, select the CD-ROM drive letter (usually D:, but it

may differ on your PC).

2. Right-click on the drive icon ( ;‘@ ) and select Sharing... to open the

drive properties dialog box.

Test-pc (C:) Properties

Genesdl| Tooks  Sherng |

Share Name: {TEST-PC

[21x]

Gomment, - This s the FC with a CD-ROM dive

Name: Accese Rights:

@) The World Full Access

Agd { i |

]

3. Select the Share as option and give full access to all users. The
CD-ROM drive icon ( @ ) should now contain a hand.

Note: For more information about file sharing, refer to the Microsoft Windows

documentation.
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Accessing the Remote CD-ROM from the
1Q-203 Through a Network

IMPORTANT

Some computers are protected from remote access by the network
security system, even if you shared drives or folders. If you are unable
to access a computer via the network, you should contact your
network administrator to verify your access rights.

To access the CD-ROM drive through a network,

1. Share the CD-ROM drive on the PC as explained in Sharing the CD-ROM
Drive from the PC on page 79.

2. ldentify the network name of the PC where the CD-ROM drive you
want to use is located. You must do this from the PC itself.

2a. Select Start > Settings > Control Panel to start the Control Panel.
2b. Double-click on Network and select the Identification tab.

2c. Note the computer name for later use (circled in the illustration).
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Accessing the Rermote CD-ROM from a PC Connected Directly to the 1Q-203

3. Before accessing the files, make sure that both the PC and the 1Q-203
are turned on (so that the PCis “visible” to the 1Q-203).

4. Open the Network Neighborhood by double-clicking on the desktop
icon or selecting it in Windows Explorer. The complete list of
computers logged on the network should appear gradually.

5. Inthe list, find the network name of the computer with the CD-ROM
drive and double click on it. You will then have access to all the shared
drives on this computer. You can use files or programs on the CD-ROM
exactly as if it were alocal drive.

Accessing the Remote CD-ROM from a PC
Connected Directly to the 1Q-203

Using the Windows’ Direct Cable Connection utility, you can connect the
PC and the 1Q-203 together using a parallel or serial cable. For this method
to work, you need to set-up both systems with the same communication
protocols.

Note: The direct method transfers data slower than a network connection.

Connecting the PC to the 1Q-203

To connect a PC to your 1Q-203,

1. Use a standard LapLink Paralle] Cable or a LapLink Serial Cable
(EXFO’s GP-216). Both are illustrated below:

Serial connector Parallel connector
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Accessing the Remote CD-ROM from a PC Connected Directly to the 1Q-203

2. Connect the parallel or serial cable between the 1Q-203 and the PC, as
shown in the following illustration:

BB 5o

Configuring a Direct Cable Connection Protocol

The Microsoft IPX/SPX-compatible protocol for Windows allows to transfer
files from the host computer {the PC with the CD-ROM drive) to the guest
computer (your 1Q-203).

IMPORTANT

The Microsoft IPX/SPX-compatible protocol must be installed on both
systems for the connection to work.

To configure the network protocols,
1. Select Start > Settings > Control Panel to start the Control Panel.

2. Double-click on Network and select the Configuration tab.
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3. Check if the IPX/SPX-compatible protocol is available in the upper list.

Network

Confyrration |1t ston | Access Cortiol}

The followinn network components are instaled:
99 Chenit fo1 Microsoft Networks
Y Realtek RTLB019 PP LAN adapter or compatible

If not, add it as follows:

3a.

Click on Add..., then double-click on Protocol.

3b. Inthe Select Netwwork Protocol dialog box, select Microsoft in the
Manufacturer list, then [PX/SPX-compatible protocol.

3c.

[21X]

The primarp rietwork logon is the clent that is uséd 1o validate
youruser name and password, process any login stripts, and
pettorm other sartup tasks

[ | cm |

4.

Optical Test System

Click on OK to add the new protocol.

Select Nelwotk Component Type

Chck the type ol network component yoas wankla instol

tﬁmlsaw‘ammz.ws g
st use the same Protoool o Communic ate. G

Select Network Protocol [ <}

szt 1 Click the Metwork Protocol that ot warg lo nstall, then ciick DK If pou have:
ST i instaation:disk: ol this device, chck Have Disk.

Network Piotocols;
T /5P compatble Pratocal

Manufactusers:

X" Banyan
¥ Digital Equipment [DEC)

£~ IBM
i NelBEYI
¥ Noved ¥ TCPAR
¥ SunSoft
Have Disk... l
Eorcd_|

In the Network Properties dialog box, ensure that the Primary Network
Logon list box is set to Windows Logon. This setting determines who
validates your user name and password, processes login scripts, and

performs other tasks at start-up.
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Accessing the Remote CD-ROM from the 1Q-203

Before accessing the CD-ROM from your 1Q-203, you need to configure
each system either as a host or a guest. Typically, the host is the PC with the
CD-ROM drive and the guest is your 1Q-203. You must also specify the
communication ports that match the physical connection.

To access the CD-ROM from your 1Q-203,
1. Configure the host so that it becomes available to the guest.

1a. Select Start > Programs > Accessories > Direct Cable Connection.
If this option is not available, refer to the Windows documentation
for installation instructions.

1 Duect Cable Conneclion

1b. Ifitis not already done, set the to Host computer set up to listen by
clicking on Change... and going through the proposed steps.
When you are done, the host is ready to accept a connection.

ect Cable Conneclian £ Diect Coble Connection

Diseet sabie Lormection enables siou io guckly and easiy: - ;
‘estableh & ot serad or paiallel cabls cormection 3 Sdect e el s werd Ao ae.

| | betwern wo comoiers.
+ o Serial cable on LOM1
v v, speciy i Serial cabde on COM2
e wsng: :

& Hat -
"This computes hes This esouriey oy wind et : i P |
o acimss. 3

7~ st i . : NOTE: vwmm:rewmdmmm »

This computer yall De: used to Scopss fesouces:
o the fost complies.

ZMmmoﬁh@

Direct Lable Connection
Youheve sicoashlly et b the host compues.
gy ienderoiatbodbeden et ot S s
s A7 AZY romimnse =)

1300 ran e mwe«wmawﬂ\ub@
m!o&mmuu« chok Uise Passward Protectin

I~ DaeRessmod poisshori

% Duect Lable Connection
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Troubleshooting Direct Cable Connection

2. Configure the guest using the same method as for the host. This time,
you must set the Direct Cable Connection utility to Guest computer set
up to connect to host. When you are done, the guest will try to establish
the connection with the host as shown below.

::, Disect Cable Connection

Bl 8 Siatis’ Connecting via Paralie) cable on
LPTL.

3. If everything is set up properly, the guest should ask you for the name
of the host computer. For details about how to find the host name, see

Accessing the Remote CD-ROM from the 1Q-203 Through a Network on
page 80.

You will then have access to all the shared drives on this computer. You can
use files or programs on the CD-ROM exactly as if it was a local drive.

Troubleshooting Direct Cable Connection

The following table provides solutions to common connection problems
when using the Direct Cable Connection:

e

The connection fails » Try changing the port to a COMx port on
using the LPTx port. both systems.

The connection does not |» Swap the host and guest systems.
work using any of the
ports. g any » Check the cable pinout.

The connection seems to |Ensure that the CD-ROM drive is shared on the
be established, but 1 host computer and that the files are not
cannot access my files. |protected from remote access.

If you are still experiencing connection problems, do not hesitate to
contact EXFO.
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